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1.  Introduction 
With the present introductory example we would like to make you acquainted with the most 
important features of RFEM. Often you have several options to achieve your targets. Depend-
ing on the situation and your preferences you can play with the software to learn more about 
the program's possibilities. With this simple example we want to encourage you to find out 
useful functions in RFEM. 

We will model a floor slab supported by columns including two downstand beams. Then, we 
will design the structure according to linear-static and second-order analysis with regard to 
the following load cases: self-weight with finishes, imposed load and imperfection. With the 
features presented we want to show you how you can define model and load objects in vari-
ous ways. 

With the 30-day trial version, you can work on the model without any restriction. After that pe-
riod, the demo mode will be applied. You can still enter the example and calculate it; saving 
data will not be possible, however. 

It is easier to enter data if you use two screens, or you may print this description to avoid 
switching between the displays of PDF file and RFEM input. 

The text of the manual shows the described buttons in square brackets, for example [Apply]. 
At the same time, they are pictured on the left. In addition, expressions used in dialog boxes, 
tables and menus are set in italics to clarify the explanations. Input required is written in bold 
letters. 

You can look up the description of program functions in the RFEM manual that you can down-
load at https://www.dlubal.com/en/downloads-and-information/documents/manuals. 

The file RFEM-Example-06.rf5 containing the model data of the following example can be 
found in the Examples project that has been created automatically during the installation. 
However, for the first steps with RFEM we recommend entering the model manually. If you 
have no time for it, you can watch the videos at https://www.dlubal.com/en/support-and-
learning/learning/videos. 

 

 

https://www.dlubal.com/en/downloads-and-information/documents/manuals
https://www.dlubal.com/en/support-and-learning/learning/videos
https://www.dlubal.com/en/support-and-learning/learning/videos
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2.  System and Loads 
 

2.1 Sketch of System 

 
Figure 2.1: Structural system 

The reinforced concrete floor consists of two continuous floor slabs with a downstand beam 
made of reinforced concrete and another one made of steel. The construction is supported by 
columns which are bending-resistant and integrated into the plate. 

As mentioned above, the model represents an "abstract" structure that can be designed also 
with the demo version whose functions are restricted to a maximum of two surfaces and 
twelve members. 

2.2 Materials, Thicknesses and Cross-Sections  
We use concrete C30/37 and steel S 235 as materials. 

The floor thickness is 20 cm. The concrete columns and the downstand beam consist of square 
cross-sections with a lateral lengths of 30 cm. For the steel beam we use an IPE 450 section. 
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2.3 Load 

Load case 1: self-weight and finishes (permanent load) 
As loads, the self-weight of the model including its floor structure of 0.75 kN/m2 is applied. We 
do not need to determine the self-weight manually. RFEM calculates the weight automatically 
from the defined materials, surface thicknesses and cross-sections. 

Load case 2: imposed load, area 1 
The floor surface represents a domestic area of category A2 with an imposed load of 1.5 kN/m2. 
The load is applied in two different load cases to cover the effects of continuity. 

Load case 3: imposed load, area 2 
The imposed load of 1.5 kN/m2 is also applied to the second area. In addition, a vertically act-
ing linear load of 5.0 kN/m is taken into account on the edge of the floor, representing a load-
ing due to a balcony construction. 

Load case 4: imperfections 
Often imperfections must be considered, for example according to Eurocode 2. Inclinations 
and precambers are managed in a separate load case. So it is possible to assign specific partial 
safety factors when you combine this type of load with other actions. 

The inclination is simplified for all columns by assuming ϕ0 = 1/200 against direction Y. Pre-
cambers do not need to be considered according to Eurocode 2. 
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3.  Creation of Model 
 

3.1 Starting RFEM 
To start RFEM in the taskbar, we 

click Start, point to All Programs and Dlubal, and then we select Dlubal RFEM 5.xx 

or we double-click the icon Dlubal RFEM 5.xx on the computer desktop. 

3.2 Creating the Model 
The RFEM work window opens showing us the dialog box below. We are asked to enter the 
basic data for the new model. 

If RFEM already displays a model, we close it by clicking Close on the File menu. Then, we 
open the General Data dialog box by clicking New on the File menu. 

 
Figure 3.1: Dialog box New Model - General Data 

We write Introductory Example in the Model Name box. To the right, we enter Floor Slab on 
Columns in the Description box. We always have to define a Model Name because it deter-
mines the name of the RFEM file. The Description box does not necessarily need to be filled in. 

In the Project Name box, we select Examples from the list if not already set by default. The pro-
ject Description and the corresponding Folder are displayed automatically. 

In the dialog section Type of Model, the 3D option is preset. This setting enables spatial model-
ing. We also keep the default setting Downward for the Positive Orientation of Global Axis Z. 

We check if the Standard option None is selected in the section Classification of Load Cases and 
Combinations. If not, we select this entry from the list. 

Now, the general data for the model is defined. We close the dialog box by clicking [OK]. 
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4.  Model Data 
 

4.1 Adjusting Work Window and Grid 
The empty work window of RFEM is displayed. 

View 
First, we click the [Maximize] button on the title bar to enlarge the work window. We see the 
axes of coordinates with the global directions X, Y and Z displayed in the workspace. 

To change the position of the axes of coordinates, we click the [Move, Zoom, Rotate] button in 
the toolbar above. The pointer turns into a hand. Now, we can position the workspace accord-
ing to our preferences by moving the pointer and holding the left mouse button down.  

Furthermore, we can use the hand to zoom or rotate the view: 

• Zoom: We move the pointer and hold the [Shift] key down. 

• Rotation: We move the pointer and hold the [Ctrl] key down. 

To exit the function, different ways are possible: 

• We click the button once again. 

• We press the [Esc] key on the keyboard. 

• We right-click into the workspace. 

Mouse functions 
The mouse functions follow the general standards for Windows applications. To select an ob-
ject for further editing, we click it once with the left mouse button. We double-click the object 
when we want to open its dialog box for editing. 

When we click an object with the right mouse button, its shortcut menu appears showing us 
object-related commands and functions. 

To change the size of the displayed model, we use the wheel button of the mouse. By holding 
down the wheel button we can shift the model directly. When we press the [Ctrl] key addition-
ally, we can rotate the structure. Rotating the structure is also possible by using the wheel but-
ton and holding down the right mouse button at the same time. The pointer symbols shown 
on the left show the selected function. 
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Grid 
The grid forms the background of the workspace. In the dialog box Work Plane and Grid/Snap, 
we can adjust the spacing of grid points. To open the dialog box, we use the [Settings of Work 
Plane] button. 

 
Figure 4.1: Dialog box Work Plane and Grid/Snap 

Later, for entering data in grid points, it is important that the SNAP and GRID options in the sta-
tus bar are set as active. In this way, the grid becomes visible and the points will be snapped 
on the grid when clicking. 

Work plane 
The XY plane is set as the work plane by default. With this setting all graphically entered ob-
jects will be generated in the horizontal plane. The plane has no significance for entering data 
in dialog boxes or tables. 

The default settings are appropriate for our example. We close the dialog box with the [OK] 
button and start with modeling the structure. 
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4.2 Creating Surfaces 
It would be possible to define corner nodes first to connect them with lines which we could 
use to create the floor surface. But in our example we use the direct graphical input of lines 
and surfaces. 

We can define the ceiling as a continuous surface by means of outlines. But it is also possible to 
represent the floor by two rectangular surfaces which are rigidly connected in a common line. 
The second way of modeling makes it easier to apply loads to two areas. 

Before we start creating the surfaces, we activate two useful functions. For this, we use the 
general shortcut menu. We right-click in an empty space of the work window to activate it. 

Show Numbering 
You can activate and deactivate functions by clicking within the shortcut menu. Active func-
tions are marked by buttons highlighted in yellow. We activate the entry Show Numbering. 

 
Figure 4.2: Show numbering in shortcut menu 

Auto Connect Lines/Members 
If the function Auto Connect Lines/Members is not active, we also activate it (please right-click 
again for the shortcut menu). It makes it easier to create the surfaces. 
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List button for plane surfaces 

4.2.1 First Rectangular Surface 
To create rectangular plates quickly, 

we click Model Data on the Insert menu, then we point to Surfaces, Plane and  
Graphically and select Rectangle, 

or we use the corresponding list button for the selection of plane surfaces. We click the arrow 
button [] to open a menu offering a large selection of surface geometries. 

With the command [Rectangular] we can define the plate directly. The related nodes and lines 
will be created automatically. 

After selecting this function, the dialog box New Rectangular Surface opens. 

 
Figure 4.3: Dialog box New Rectangular Surface 

The Surface No. of the new rectangular plate is specified as 1. It is not necessary to change this 
number. 

The Material is preset as Concrete C30/37 according to EN 1992-1-1. When we want to use a dif-
ferent material, we can select another one using the [Material Library] button. 

The Thickness of the surface is Constant. We increase the value d to 200 mm, either by using 
the spin box or by typing the value. 

In the dialog section Surface Type the Stiffness is preset appropriately with Standard. 

We close the dialog box with the [OK] button and start the graphical definition of the slab. 

We can make the surface definition easier when we set the view in Z-direction (top view) by 
using the button shown on the left. The input mode will not be affected. 
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To define the first corner, we click with the left mouse button on the coordinate origin 
(coordinates X/Y/Z 0.000/0.000/0.000). The current pointer coordinates are displayed next  
to the reticle. 

Then, we define the opposite corner of the slab by clicking the grid point with the X/Y/Z 
coordinates 6.000/5.000/0.000. 

 
Figure 4.4: Rectangular surface 1 

RFEM creates four nodes, four lines and one surface. 

4.2.2 Second Rectangular Surface 
As the function is still active, we can define the next surface immediately. 

We click node 4 with the coordinates 6.000/0.000/0.000, and then we select the grid point 
with the coordinates 10.000/8.000/0.000. 

 
Figure 4.5: Rectangular surface 2 

As we don't want to create any more plates, we quit the input mode by pressing the [Esc] key. 
We can also use the right mouse button to right-click in an empty area of the work window. 
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4.3 Creating Members 

4.3.1 Downstand Beams 

We specify member properties for the lines 3 and 7 to define two downstand beams. 

4.3.1.1 Steel Girder 
We open the dialog box Edit Line by double-clicking line 7. 

We switch to the second tab Member where we select the check box for the option Available.  
The dialog box New Member appears. 

 
Figure 4.6: Dialog box New Member 

It is not necessary to change the default settings. We only have to create a Cross-Section. To  
define the cross-section at the Member start, we click the [New] button. 

The New Cross-Section dialog box appears. We click the [IPE] button in the upper part of the 
dialog box. The Rolled Cross-Sections - I-Sections dialog box opens where we can select the 
section IPE 450 from the IPE cross-section table (see Figure 4.7). 

For rolled cross-sections RFEM automatically sets the Material number 2 - Steel 235. 
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Figure 4.7: Selecting the cross-section IPE 450  

We click [OK] to import the cross-section values to the New Cross-Section dialog box. 

 
Figure 4.8: Dialog box New Cross-Section with cross-section properties 

We click [OK] and return to the initial New Member dialog box. Now the Member start box 
shows the new cross-section. We close the dialog box with [OK]. We also close the Edit Line 
dialog box with the [OK] button. The steel girder is now displayed on the edge of the floor. 
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4.3.1.2 T-Beams 
We define the downstand beam below the ceiling in the same way: We double-click line 3 to 
open the Edit Line dialog box. In the Member tab, we select the option Available (see Figure 4.6). 

Definition of cross-section 
The New Member dialog box opens. To define the cross-section at the Member start, we click 
the [New] button again (see Figure 4.6). 

In the upper part of the New Cross-Section dialog box, we select the massive REC cross-section 
table. The Solid Cross-Sections - Rectangle dialog box opens where we define the width b and 
the depth h as 300 mm. 

 
Figure 4.9: Dialog box Solid Cross-Sections - Rectangle 

We can use the [Info] button to check the properties of the cross-section. 

For solid cross-sections RFEM automatically sets the Material number 1 - Concrete C30/37. 

We click [OK] to import the cross-section values to the New Cross-Section dialog box. 

We click [OK] and return to the initial dialog box New Member. Now the Member start box 
shows the rectangular cross-section. 
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Definition of rib 
In RFEM a downstand beam can be modeled with the member type Rib. We just change the 
Member Type in the New Member dialog box: We select the entry Rib from the list. 

 
Figure 4.10: Changing the member type 

Then, we click the [Edit] button to the right of the list box to open the New Rib dialog box. 

 
Figure 4.11: Defining the rib 

We define the Position and Alignment of the Rib On +z-side of surface. This is the bottom side 
of the floor slab. 

As Integration Width, we specify L/8 for both sides. RFEM will find the surfaces automatically. 

We close all dialog boxes with the [OK] button and check the result in the work window. 
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Changing the view 

We use the toolbar button shown on the left to set the [Isometric View] because we want to 
display the model in a 3D graphical representation. 

To adjust the display, we use the [Move, Zoom, Rotate] button (see "mouse functions", page 8). 
The pointer turns into a hand. When we hold down the [Ctrl] key additionally, we can rotate the 
model by moving the pointer. 

 
Figure 4.12: Model in isometric view with navigator and table entries 

Checking data in navigator and tables 
All entered objects can be found in the directory tree of the Data navigator and in the tabs of 
the table. The entries in the navigator can be opened (like in Windows Explorer) by clicking the 
[+] sign. To switch between the tables, we click the individual table tabs. 

For example, in the navigator entry Surfaces and in Table 1.4 Surfaces, we see the input data of 
both surfaces in numerical form (see figure above). 

4.3.2 Columns 
The most comfortable way to create columns is copying the floor nodes downward by specify-
ing particular settings for the copy process. 

Node selection 
First, we select the nodes that we want to copy. To open the corresponding dialog box, 

we select Select on the Edit menu, and then we click Special 

or we use the toolbar button shown on the left. 

In the Special Selection dialog box, we select the All check box of the Nodes category in order 
to select all nodes of our model (see Figure 4.13). 

Then we confirm the dialog box  with the [OK] button. 

 



4  Model Data 

 

 
Dlubal 

18 RFEM Introductory Example © 2016 Dlubal Software GmbH 

 

 
Figure 4.13: Dialog box Special Selection 

The selected nodes are now displayed with a different color. Yellow is the default selection 
color for black backgrounds. (If a surface has been selected additionnally, it can be removed 
from the selection by holding the [Ctrl] key and clicking the surface.) 

Copying nodes 
We use the button shown on the left to open the Move or Copy dialog box. 

 
Figure 4.14: Dialog box Move or Copy 

We increase the Number of copies to 1: With this setting the nodes won't be moved but copied. 
As the columns are 3 m high, we enter the value 3.0 m for the Displacement Vector in dz. 
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Now, we click the [Details] button to specify more settings. 

 
Figure 4.15: Dialog box Detail Settings for Move/Rotate/Mirror 

In the dialog section Connecting, we select the check boxes for the following options: 

  Create new lines between the selected nodes and their copies 

  Create new members between the selected nodes and their copies 

Then, we select member 2 from the list to define it as the Template member. Thus, the properties 
of the T-beam (member type, cross-section, material) are automatically set for the new columns. 

We close both dialog boxes by clicking the [OK] button. 

Editing surfaces 
Because we defined the template member as a Rib with integration widths, we now have to 
adjust the member type. We choose another way for the selection of columns. 

First, we set the view in the [Y] direction by using the button shown on the left. 

Now, we use the pointer to draw a window from the right to the left across the footing nodes 
of the columns. In this way, we select all objects that are completely or only partially contained 
in the window, so our columns are selected as well. (When we draw the window from the left 
to the right, we select only those objects that are completely contained in the window). 
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Figure 4.16: Selecting with window 

Now, we double-click one of the selected columns. The Edit Member dialog box appears.  
The numbers of the selected members are shown in the Member No. box. 

 
Figure 4.17: Adjusting the member type 

We change the member type to Beam and close the dialog box with the [OK] button. 

Again, we set the [Isometric View] to display our model completely. 
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Figure 4.18: Full isometric view 
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4.4 Support Arrangement 
The model is still without supports. In RFEM we can assign supports to nodes, lines, members 
and surfaces. 

Assigning nodal supports 
The columns are supported in all directions on their footing but are without restraints. 

The foot nodes and the columns remain selected as long as we do not click in the work win-
dow. If necessary, we select those objects again by window selection (see Figure 4.16). 

Now, we double-click one of the selected foot nodes. Watching the status bar in the bottom 
left corner we can check if the pointer is placed on the relevant node. 

The dialog box Edit Node opens. 

 
Figure 4.19: Dialog box Edit Node, tab Support 

In the Support tab, we select the check box Available. With this setting we assign the Hinged 
support type to the selected nodes. 

After clicking the [OK] button we can see the support symbols displayed in the model. 

Changing the work plane 
We want to correct the length of the two columns on the left to 4 m. Therefore, we shift the 
work plane from the horizontal to the vertical plane. 

To set the [Work Plane YZ], we click the second of the three plane buttons. 

The grid is now displayed within the plane of the left columns. This setting allows us to define 
lines graphically or to displace nodes in this work plane. 
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Adjusting support nodes 
We cancel the selection of nodes by clicking with the left mouse button into an "empty" space 
of the work window. 

Now, we shift node 9 with the mouse by 1 m to the grid point below. Please take care to select 
the node and not the member. Again, we can check the node numbers and the coordinates of 
the pointer in the status bar. 

We repeat the same step for node 8. 

 

Figure 4.20: Shifting support node  

Alternatively, it would be possible to double-click one of the nodes and to enter the correct  
Z-coordinate in the Edit Node dialog box. 
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4.5 Connecting Member with Hinge and  
Eccentricity 

4.5.1 Hinge 
The steel girder cannot transfer any bending moments to the columns because of its connec-
tion. Therefore, we have to assign hinges to both sides of the member. 

We double-click member 1 to open the Edit Member dialog box. 

In the Member Hinge dialog section, we click the [New] button to define a hinge type for the 
Member start (see also Figure 4.23). 

 
Figure 4.21: Dialog box Edit Member, dialog section Member Hinge 

The New Member Hinge dialog box appears in which the displacements or rotations can be se-
lected that are released at the member end. In our example, we select the check boxes for the 
rotations φy and φz. Thus, no bending moments can be transferred at the node. 

 
Figure 4.22: Dialog box New Member Hinge 

We confirm the default settings and close the dialog box by clicking the [OK] button. 

In the Edit Member dialog box we see that hinge 1 is now entered for the Member start. We de-
fine the same hinge type for the Member end by using the list (see Figure 4.23). 
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Figure 4.23: Assigning hinges in the Edit Member dialog box 

4.5.2 Member Eccentricity 
We want to connect the steel girder eccentrically below the floor slab. 

In the Edit Member dialog box, we switch to the Options tab. In the Member Eccentricity section, 
we click the [New] button to open the New Member Eccentricity dialog box. 

 
Figure 4.24: Dialog box New Member Eccentricity 
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We select the option Transverse offset from cross-section of other object. In our example, the ob-
ject is the floor slab: We use the [Pick] function to define Surface 2 graphically. 

Then, we define the Cross-section alignment as well as the Axis offset as shown in Figure 4.24. 
Please watch out the local axis system on the picture 

In the dialog section Axial offset from adjoining members, we select the check boxes for Mem-
ber start and Member end to arrange the offset on both sides. 

After confirming all dialog boxes we can check the result with a maximized view (for example 
zooming by rotating the wheel button, moving by holding down the wheel button, rotating 
by holding down the wheel button and the right mouse button). 

 
Figure 4.25: Steel girder with release and eccentricity 

4.6 Checking the Input 

Checking Data navigator and tables 
The graphical input is reflected in both the Data navigator tree and the tables. We can display 
and hide the navigator and tables by selecting Navigator or Table on the View menu. We can 
also use the corresponding toolbar buttons. 

In the tables, structural objects are organized in numerous tabs. Graphics and tables are inter-
active: To find an object in the table, for example a surface, we set Table 1.4 Surfaces and select 
the surface in the work window by clicking it. We see that the corresponding table row is high-
lighted (see Figure 4.12, page 17). 

We can check the entered numerical data quickly. 

Saving data 
Finally, the entry of model data is complete. To save our file, 

we select Save on the File menu 

or use the toolbar button shown on the left. 
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5.  Loads 
First, loads such as self-weight, imposed or wind loads are described in different load cases. In 
the next step, we superimpose the load cases with partial safety factors according to specific 
combination rules (see Chapter 6). 

5.1 Load Case 1: Self-Weight and Finishes 
The first load case contains the permanently acting loads from self-weight and floor structure 
(see Chapter 2.3, page 6). 

We use the [New Surface Load] button to create a load case. 

 
Figure 5.1: Button New Surface Load 

The dialog box Edit Load Cases and Combinations appears. 

 
Figure 5.2: Dialog box Edit Load Cases and Combinations, tabs Load Cases and General 

Load case No. 1 is preset with the action type G Permanent. In addition, we enter the Load Case 
Description Self-weight and finishes. 
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5.1.1 Self-weight 
 The Self-Weight of surfaces and members in the Z-direction is automatically taken into account 
when the Active check box is selected and the factor is specified as -1.000  by default. 

5.1.2 Floor Structure 
We confirm the entry by clicking the [OK] button. The New Surface Load dialog box opens. 

 
Figure 5.3: Dialog box New Surface Load 

The floor structure is acting as load type Force, the load distribution is Uniform. We accept the 
default settings as well as the Global ZL setting in the Load Direction section. 

In the Load Magnitude dialog section, we enter a value of 0.75 kN/m2 (see Chapter 2.3, page 6). 
Then, we close the dialog box by clicking [OK]. 

Now, we can assign the load graphically to the floor surface: We can see that a small load sym-
bol has appeared next to the pointer. This symbol disappears as soon as we move the pointer 
across a surface. We apply the load by clicking the surfaces 1 and 2 one after the other (see 
Figure 5.4). 

We can hide and display the load values with the toolbar button [Show Load Values]. 

To quit the input mode, we use the [Esc] key. We can also right-click in the empty work win-
dow. The input for the load case Self-weight and finishes is complete. 
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Figure 5.4: Graphical input of floor load 

5.2 Load Case 2: Imposed Load, Area 1 
We divide the imposed load of the floor into two different load cases because of the effects of 
continuity. To create a new load case, 

we point to Loads on the Insert menu and select New Load Case 

or we use the corresponding button in the toolbar (to the left of the load case list). 

 
Figure 5.5: Dialog box Edit Load Cases and Combinations, tab Load Cases 

For the Load Case Description we enter Imposed load, or we choose the entry from the list. 
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The Action Type is set automatically to Qi Imposed. This classification is important for the par-
tial safety factors and combination coefficients of the load combinations. 

In the Comment box, we can enter Area 1 to describe the load case in detail. 

After confirming, we enter the surface load in a new entry method: First, we select floor surface 
1 by clicking. Now, when we open the dialog box by means of the [New Surface Load] button, 
we can see that the number of the surface is already entered. 

 
Figure 5.6: Dialog box New Surface Load 

The imposed load is acting as load type Force, the load distribution is Uniform. We accept these 
default settings as well as the Global ZL setting in the Load Direction section. 

In the Load Magnitude dialog section, we enter a value of 1.5 kN/m2 (see Chapter 2.3, page 6). 
Then, we close the dialog box by clicking [OK]. 

The surface load is displayed in the left area of the floor. 
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5.3 Load Case 3: Imposed Load, Area 2 
We create a [New Load Case] to enter the imposed load of the right area. 

 
Figure 5.7: Dialog box Edit Load Cases and Combinations, tab Load Cases 

Again, we enter Imposed load for the Load Case Description. In the Comment box, we enter 
Area 2. Then we close the dialog box with [OK]. 

5.3.1 Surface Load 
This time we select floor surface 2 and open the dialog box New Surface Load with the [New 
Surface Load] button. 

In addition to surface 2, we can see that the parameters of the recent entry are automatically 
set (load type Force, load distribution Uniform, load direction Global ZL, Load Magnitude 1.5 kN/m2 
– see Figure 5.6). We can confirm the dialog box without making any changes. 

The surface load is displayed in the right area of the floor (see Figure 5.8). 
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5.3.2 Line Load 
It is easier to apply a line load to the rear edge of the floor when we maximize the display of 
this area by using the Zoom function or the wheel button. 

With the [New Line Load] toolbar button to the left of the [New Surface Load] button we open 
the New Line Load dialog box. 

The line load as load type Force with a Uniform load distribution is acting in the ZL load direc-
tion. In the Load Parameters dialog section, we enter 5 kN/m (see Chapter 2.3, page 6). 

 
Figure 5.8: Dialog box New Line Load 

After clicking the [OK] button we click line 8 at the floor's rear edge (check by status bar). 

We close the input mode with the [Esc] button or by right-clicking in the empty workspace. 
Then, we reset the [Isometric View]. 
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5.4 Load Case 4: Imperfections 
In the final load case we define imperfections for the columns that are stressed by axial force. 

This time, we use the Data navigator to create a new load case: We right-click the entry Load 
Cases to open the shortcut menu, and then we select New Load Case. 

 
Figure 5.9: Shortcut menu Load Cases 

We choose Imperfection in -Y from the Load Case Description list. The Action Type changes 
automatically to Imp Imperfection. 

 
Figure 5.10: Dialog box Edit Load Cases and Combinations, tab Load Cases 

We close the dialog box by clicking the [OK] button. 
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List button for loads 

We click the [New Solid Load] toolbar button to open the menu where we select the New 
Imperfection. The following dialog box opens. 

 
Figure 5.11: Dialog box New Imperfection 

We want to apply the imperfection in the Direction of the column axes y, which is the direction 
of the minor member axis that is aligned parallel with the global Y-axis in our example. 

We set the Precamber L/e0 to 0.00 and confirm the dialog box by clicking the [OK] button. 

We can assign the imperfection easily by using a selection window. First, we put the model in a 
more appropriate position: We click the [Move, Zoom, Rotate] button and incline the model a 
little bit backwards by holding down the left mouse button and keeping the [Ctrl] key addi-
tionally pressed. We stop changing the view with the [Esc] button or a right-click in the win-
dow without canceling the function "Select Members for Imperfections". 

Then, we draw a selection window from the right to the left. We have to take care that we 
catch each column with the window, but the steel girder must lie outside the selection zone. 

 
Figure 5.12: Selecting columns for imperfections 

When the second corner of the window is set, RFEM assigns the imperfections. 
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We quit the function with the [Esc] key or a right-click. Finally, we reset the [Isometric View]. 

 
Figure 5.13: Imperfections shown in line model 

Changing the model display 
The figure above shows the structure as Wireframe Display Model. We can set this display op-
tion with the toolbar button shown on the left. In this way, the imperfections are no longer 
overlapped by rendered columns. 

5.5 Checking Load Cases 
All four load cases have been completely entered. It is recommended to [Save] the model now. 

We can check each load case quickly in the graphics: The arrow buttons [] and [] in the 
toolbar allow us to select previous and subsequent load cases. 

 
Figure 5.14: Browsing the load cases 

The loading's graphical input is also reflected in both the Data navigator tree and the tables. 
We can access the load data in Table 3. Loads which can be set with the button shown on the 
left. 

Again, the graphic and tables are interactive: To find a load in the table, for example an imper-
fection, we set Table 3.14 Imperfections, and then we select the load in the work window. We 
see that the pointer jumps into the corresponding row of the table. 
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6.  Combination of Load Cases 
According to EN 1990, we have to combine the load cases with factors. The Action Type speci-
fied before, when we created the load cases, makes generating combinations easier (see Fig-
ure 5.10, page 33). In this way, we can control the partial safety factors and combination coeffi-
cients when combinations are created. 

6.1 Creating Load Combinations 
With our four load cases we create the following load combinations: 

• 1.35*LC1 + 1.5*LC2 + 1.0*LC4  Imposed load in area 1 

• 1.35*LC1 + 1.5*LC3 + 1.0*LC4  Imposed load in area 2 

• 1.35*LC1 + 1.5*LC2 + 1.5*LC3 + 1.0*LC4 Full load 

We calculate the model according to nonlinear second-order analysis. 

Creating CO1 
We open the menu for [Load Cases and Combinations] and create a New Load Combination. 
The Edit Load Cases and Combinations dialog box appears again. 

 
Figure 6.1: Dialog box Edit Load Cases and Combinations, tab Load Combinations 

We enter Imposed load in area 1 for the Load Combination Description. 

Below, in the list Existing Load Cases, we click LC1. Then, we use the [] button to transfer the 
load case to the list Load Cases in Load Combination CO1 on the right. We do the same with LC2 
and LC4. 

In the tab Calculation Parameters, we check if the Method of Analysis is set according to Second-
order analysis (see the following picture). 
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Figure 6.2: Tab Calculation Parameters 

After clicking [OK] all loads contained in the load combination are shown in the model.  
The factors of the load cases have been considered for the values. 

 
Figure 6.3: Loads of load combination CO1 

Furthermore, we can use the Calculation Parameters tab to check the specifications applied by 
RFEM for the calculation of different load combinations. 

Creating CO2 
We create the second load combination in the same way: We create a [New Load Combination], 
but this time we enter Imposed load in area 2 for the Load Combination Description. 

The load cases which are relevant for this load combination are LC1, LC3 and LC4. Again, we 
use the [] button to select them. 
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Creating CO3 
To create the last load combination, we choose another way of creation: We right-click the 
navigator entry Load Combinations and select New Load Combination in the shortcut menu. 

 
Figure 6.4: Creating COs using the navigator shortcut menu 

We enter Full load for the Load Combination Description. With the [Add All Load Cases] button 
we can transfer all four load cases together to the list on the right. 

 
Figure 6.5: Dialog box Edit Load Cases and Combinations, tab Load Combinations 

As the load cases LC2 and LC3 are assigned to the action type Imposed, they are both applied 
with the partial safety factor 1.5. In the case of different categories one load case would be the 
leading action, the other one would be the secondary load with reduced factor. 
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6.2 Creating Result Combinations 
From the results of the three load combinations we create an envelope containing the positive 
and negative extreme values. 

In the menu for [Load Cases and Combinations], we select New Result Combination. We see the 
Edit Load Cases and Combinations dialog box which is already familiar to us. 

 
Figure 6.6: Dialog box Edit Load Cases and Combinations, tab Result Combinations 

We choose Governing Result Combination from the Result Combination Description list. 

To display the load combinations in the dialog section Existing Loading, we select CO Load 
Combinations from the list below the load table on the left. Then, we select all three load com-
binations by clicking the [Select All Listed Loading] button. 

The selection box below the load table on the right indicates the superposition factor which is 
preset to 1.00. The setting conforms to our intention to determine the extreme values of this 
load combination. We change the superposition rule to Permanent in the list for all load com-
binations. Thus, RFEM always takes into account at least one of the actions. 

We use the [Add Selected with 'or'] button to transfer the three load combinations to the list 
on the right. The value 1 below the final column tells us that all entries belong to the same 
group: They won't be treated as additive but alternatively acting. 

Now, the superposition criteria is completely defined. We click [OK] and [Save] the entry. 
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7.  Calculation 
 

7.1 Checking Input Data 
Before we calculate our structure, we want RFEM to check our structural and load data.  
To open the corresponding dialog box, 

we select Plausibility Check on the Tools menu. 

The Plausibility Check dialog box opens where we define the following settings. 

 
Figure 7.1: Dialog box Plausibility Check 

If no error is detected after clicking [OK], the following message is displayed. In addition, a 
short summary of structural and load data is shown. 

 
Figure 7.2: Result of plausibility check 

We find more tools for checking the structural and load data by selecting 

Model Check on the Tools menu. 
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7.2 Generating the FE Mesh 
As we have selected the option Generate FE mesh in the Plausibility Check dialog box (see Fig-
ure 7.1), we have automatically generated a mesh with the standard mesh size of 50 cm. (We 
can modify the default mesh size by selecting FE Mesh Settings on the Calculate menu.) 

 
Figure 7.3: Model with generated FE mesh 

7.3 Calculating the Model 
To start the calculation, 

we select Calculate All on the Calculate menu 

or we use the toolbar button shown on the left. 

 
Figure 7.4: Calculation process 
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8.  Results 
 

8.1 Graphical Results 
As soon as the calculation is finished, RFEM displays the deformations of the load case current-
ly set. The last load setting was RC1, so now we see the maximum and minimum results of this 
result combination. 

 
Figure 8.1: Graphic of max/min deformations for result combination RC1 

Selecting load cases and load combinations 
We can use the toolbar buttons [] and [] (to the right of the load case list) to switch between 
the results of load cases, load combinations and result combinations. We already know the but-
tons from checking the load cases. It is also possible to select the loads in the list. 

 
Figure 8.2: Load case list in the toolbar 

Selecting results in the navigator 
A new navigator has appeared which manages all result types for the graphical display. We can 
access the Results navigator when the results display is active. We can switch the results display 
on and off in the Display navigator, but we can also use the toolbar button [Show Results] 
shown on the left. 

The check boxes for the individual results categories (for example Global Deformations, Mem-
bers, Surfaces, Support Reactions) determine which deformations or internal forces are shown. 
Within these categories are even more individual types of results that we can select for display. 
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Finally, we can browse the single load cases and load combinations. The various result catego-
ries allow us to display deformations, internal forces of members and surfaces, stresses or sup-
port forces. 

 
Figure 8.3: Setting internal forces of members and surfaces in Results navigator  

In the figure above, we see the member internal forces My and the surface internal forces my 
calculated for CO1. To display the forces, it is recommended to use the wire-frame model. We 
can set this display option with the button shown on the left.  

Display of values 
The color scale in the control panel shows us the color range. We can switch on the result val-
ues by selecting the option Values on Surfaces in the Results navigator. To display all values of 
the FE mesh nodes or grid points, we clear the selection for Extreme Values additionally. 

 

Figure 8.4: Grid point moments mx of floor slab in Z-view (CO1) 
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8.2 Results Tables 
We can also evaluate results in tables. 

The results tables are displayed automatically when the structure has been calculated. Like for 
the numerical input we see different tables with results. Table 4.0 Summary offers us a sum-
mary of the calculation process, sorted by load cases and combinations. 

 
Figure 8.5: Table 4.0  Results - Summary 

To select other tables, we click the corresponding table tabs. To find specific results in the ta-
ble, for example the internal forces of floor surface 1, we set Table 4.15 Surfaces - Basic Internal 
Forces. Now, we select the surface in the graphic (the transparent model representation makes 
the selection easier) and we see that RFEM jumps to the surface's basic internal forces in the 
table. The current grid point, that means the position of the pointer in the table row, is indicat-
ed by an arrow in the graphic. 

 
Figure 8.6: Surface internal forces in Table 4.15 and marker of current grid point in the model 

Like the browsing function in the main toolbar, we can use the arrow buttons [] and [] to 
select a load case or combination in the table. We can also use the list in the table toolbar. 
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Results Navigator 

8.3 Filter Results 
RFEM offers us different ways and tools by which we can represent and evaluate results in 
clearly-structured overviews. We can use these tools also for our example. 

We display the member internal force My in the Results navigator. We deactivate the display of 
the internal forces in surfaces as well as the values on surfaces (see figure on the left). 

8.3.1 Visibilities 
Partial views and sections can be used as so-called Visibilities in order to evaluate results. 

Results display for concrete columns 
We click the tab Views in the navigator. We select the following entries listed under Generated: 

• Members sorted by type:  Beam 

• Members sorted by cross-section: 2 - Rectangle 300/300 

In addition, we create the intersection of both options with the [Show Intersection] button. 

 
Figure 8.7: Moments My of concrete columns in scaled representation 

The display shows the concrete columns including results. The remaining model is displayed 
lighter and without results. 

Adjusting the scaling factor 
In order to check the diagram of internal forces on the rendered model without difficulty, we 
scale the data display in the control tab of the panel. We change the factor for Member diagrams 
to 2 (see figure above). 
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Results display of floor slab 
In the same way, we can filter surface results in the View navigator. We deactivate the options 
Members by Type and Members by Cross-Section and select Surfaces by Thickness where we se-
lect the entry 200 mm. 

 
Figure 8.8: Shear forces of floor 

As already described, we can change the display of result types in the Results navigator (see 
Figure 8.3, page 43). The figure above shows the distribution of the shear forces vy for CO1. 
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8.3.2 Results on Objects 
Another possibility to filter results is using the filter tab of the control panel where we can 
specify numbers of particular members or surfaces to display their results exclusively. In  
contrast to the visibility function, the model will be displayed completely in the graphic. 

First, we clear the selection for Visibilities in the Views navigator. 

 
Figure 8.9: Resetting the overall view in Views navigator 

We select surface 1 with one click. Then, in the panel, we change to the filter tab and check if 
Surfaces is selected. 

We click the [Import from Selection] button and see that the number of the selected surface 
has been entered into the box above. Now, the graphic shows only the results of the left sur-
face. 

 
Figure 8.10: Shear force diagram of left surface 

We use the panel option All to reset the full display of results. 
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Shortcut menu Member 

8.4 Display of Result Diagrams 
We can evaluate results also in a diagram available for lines, members, line supports and sec-
tions. Now, we use this function to look at the result diagram of the T-beam. 

We right-click member 2 (when we have problems we can switch off the surface results) and 
select the option Result Diagrams. 

A new window opens displaying the result diagrams of the rib member. 

 
Figure 8.11: Display of result diagrams of downstand beam 

In the navigator, we select the check boxes for the global deformations u and the internal forc-
es My and V-L. The last option represents the longitudinal shear force between surface and 
member. These forces are displayed when the [Results with Ribs Component] button is set ac-
tive in the toolbar. When we click the button to turn it on and off, we can clearly see the differ-
ence between pure member internal forces and rib internal forces with integration compo-
nents from the surfaces. 

To adjust the size of the displayed result diagrams, we use the buttons [+] and [-]. 

The arrow buttons [] and [] for load case selection are also available in the result diagram 
window. But we can also use the list to set the results of a load case. 

We quit the function Result Diagrams by closing the window. 
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9. Documentation 
 

9.1 Creation of Printout Report 
It is not recommended to send the complex results output of an FE calculation directly to the 
printer. Therefore, RFEM generates a print preview first, which is called the "printout report" 
containing input and result data. We use the report to determine the data that we want to in-
clude in the printout. Moreover, we can add graphics, descriptions or scans. 

To open the printout report, 

we select Open Printout Report on the File menu 

or we use the button shown on the left. A dialog box appears where we can specify a Template 
as a sample for the new printout report. 

 
Figure 9.1: Dialog box New Printout Report 

We accept template 1 - Input data and reduced results and generate the print preview with [OK]. 

 
Figure 9.2: Print preview in printout report 
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9.2 Adjusting the Printout Report 
Also the printout report has a navigator which lists the selected chapters. By right-clicking a 
navigator entry we can see the corresponding contents in the window to the right. 

The default contents can be specified in detail. Now, we adjust the output of the member in-
ternal forces: Under Results - Result Combinations, we right-click Cross-Sections - Internal Forces, 
and then we click Selection. 

 
Figure 9.3: Shortcut menu Cross-Section - Internal Forces  

A dialog box appears, offering detailed selection options for RC results of members. 

 
Figure 9.4: Reducing output of internal forces by means of Printout Report Selection 

We place the pointer in table cell 4.12 Cross Sections - Internal Forces. The [...] button becomes 
active which opens the dialog box Details - Internal Forces by Cross-Section. Now, we reduce the 
output to the Extreme values of the internal forces N, Vz and My. 
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After confirming the dialog box we see that the table of internal forces has been updated in 
the printout report. We can adjust the remaining chapters for the printout in the same way. 

To change the position of a chapter within the printout report, we move it to the new position 
using the drag-and-drop function. When we want to delete a chapter, we use the shortcut 
menu (see Figure 9.3) or the [Del] key on the keyboard. 

9.3 Inserting Graphics in Printout Report 
Often, we integrate graphics in the printout to illustrate the documentation. 

Printing deformation graphics 
We close the printout report with the [X] button. The program asks us Do you want to save the 
printout report? We confirm this query and return to the work window of RFEM. 

In the work window, we set the Deformation of CO1 - Imposed load in area 1 and put the 
graphic in an appropriate position. 

As deformations can be displayed more clearly as Wireframe Display Model, we set the corre-
sponding display option. 

Unless not already set, we change the display to All surfaces in the filter tab of the panel. 

 
Figure 9.5: Deformations of CO1 

Now, we transfer this graphical representation to the printout report. 

We select Print Graphic on the File menu 

or use the toolbar button shown on the left.  

 

 



9  Documentation 

 

 
Dlubal 

52 RFEM Introductory Example © 2016 Dlubal Software GmbH 

We set the following print parameters in the Graphic Printout dialog box. It is not necessary to 
change the default settings in the Options and Color Spectrum tabs. 

 
Figure 9.6: Dialog box Graphic Printout 

We click [OK] to print the deformation graphic to the printout report. 

The graphic appears at the end of chapter Results - Load Cases, Load Combinations. 

 
Figure 9.7: Deformation graphic in printout report 
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Printing the printout report 
When the printout report is completely prepared, we can send it to the printer by using the 
[Print] button. 

The PDF print device integrated in RFEM makes it possible to save report data as a PDF file.  
To activate the function, 

we select Export to PDF on the File menu. 

In the Windows dialog box Save As, we enter file name and storage location. 

By clicking the [Save] button we create a PDF file with bookmarks. They facilitate navigating in 
the digital document. 

 
Figure 9.8: Printout report as PDF file with bookmarks 
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10.   Outlook 
Now, we have reached the end of the introductory example. We hope that this short introduc-
tion helps you to get started with RFEM and makes you curious to discover more of the pro-
gram functions. You can find a detailed program description in the RFEM manual that you can 
download at https://www.dlubal.com/en/downloads-and-information/documents/manuals. 
On this download page, you can also find a tutorial example describing more comprehensive 
program functions. 

With the Help menu or the [F1] key it is possible to open the program's online help system 
where you can search for particular terms like in the manual. The help system is based on the 
RFEM manual. 

Finally, if you have any questions, you are welcome to use our free e-mail hotline or to have a 
look at the FAQ page at www.dlubal.com or on our DLUBAL blogs at www.dlubal.com/blog. 

Note: This example can be continued in the add-on modules, for example for steel and rein-
forced concrete design (RF-STEEL Members, RF-CONCRETE Surfaces/ Members etc.). In this 
way, you will be able to perform further design, getting an insight into the functionality of the 
add-on modules. Then, you can also evaluate the design results in the RFEM work window. 
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